**Hunter Scholar for 1999**

**Dr. James Costa**

**Non-Traditional Social Insects?**

by Bill Kirwan, University Librarian

What are non-traditional social insects? Colonies of ants or bees that practice alternative life styles? Hardly. But they are one of the principal research interests of James Costa, Assistant Professor of Biology and Hunter Scholar for 1999. He explains that the scientific work on social insects “is largely based on studies of ants, bees, wasps and termites—species characterized by specialized worker, soldier and reproductive castes.” He studies social insects falling outside this traditional framework such as tent caterpillars and earwigs.

No single comprehensive treatment of these non-traditional societies has been written and last year Dr. Costa was offered a book contract by Harvard University Press to produce such a work. He commented that, “The Hunter Scholar Award [will] provide me with the time and resources to focus on castes.”

**Continued on page 2**

---

**In This Issue**

- Statistical Corner .................................. 2
- Scholar (cont.) ........................................ 2
- Databases Off-Campus (cont.) ..................... 2
- Map Room & GIS ..................................... 3
- Survey ................................................... 3
- PC Tip ..................................................... 4
- Friends of Hunter Library .......................... 4
- New Employee ........................................ 5
- New Resources ....................................... 5
- Hours .............................................. mailing page

**Librarians Offer Instruction to Faculty & Staff**

by Nan Watkins, Reference Librarian

Hunter librarians continue to offer instruction in the use of library resources to all WCU faculty and staff. This spring we have scheduled one class each of **Good Web Searching** and **Online Databases** in the library’s electronic classroom. We are also available to come to your department for group or individual instruction on any subject. Please do not hesitate to contact us when you have questions about using the library’s online or print resources.

The following two hands-on workshops have been scheduled in our electronic classroom, Hunter 186:

<table>
<thead>
<tr>
<th>Good Web Searching</th>
<th>Online Databases</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Training Center</strong></td>
<td><strong>Tuesday, March 2 at 3:00</strong></td>
</tr>
<tr>
<td><strong>Friday, February 26 at 3:00</strong></td>
<td>Gives overview of the many general and subject-specific databases available through Hunter Library’s homepage.</td>
</tr>
<tr>
<td>Teaches effective ways to focus and narrow Web searching to retrieve good results.</td>
<td></td>
</tr>
</tbody>
</table>

**Databases Available Off-Campus**

by Jill Ellern, Systems Analyst

The Western North Carolina Library Network (WNCLN) has purchased and installed software making it possible for faculty, staff and students to use online databases from off-campus. This is great news for those of you who like to use the library resources from home. You can now access most of the online full-text databases like Academic Universe, EBSCOHost, and ProQuest regardless of your Internet provider.

In order to use this new service, you must be using Netscape 3.00 or above OR Internet Explorer 3.02 or above. (You cannot use AOL’s browser software or NetTV.) You will be required to configure your browser to use a proxy server. The instruc-

**Continued on page 2**
Statistical information on the state of North Carolina is available from multiple state and federal agencies on the Internet. Over the next few issues we will be listing resources, some with Web sites, in various subject areas on North Carolina Counties & Cities Statistical Information, compiled by Alex Hess, Acting Librarian from the Institute of Government. For additional information on any of these sites or to suggest a recommendation for best sites, please call Nancy Kolenbrander at 7252.

North Carolina Counties & Cities Statistical Information

Old North State: State, County, and Local Information - May 15, 1998

Elections:
North Carolina Manual, N.C. Dept. of the Secretary of State, Legislative Office Bldg., 300 N. Salisbury St., Raleigh, NC, 27603-5909 (919-733-4098; Fax 919-733-4092) (issued every two years)
Voter Registration in North Carolina, North Carolina State Board of Elections
http://www.state.nc.us/SBOE/voterrreg.htm

Employment:
http://www.esc.state.nc.us/lmi/laus/clf/selcty2.htm
http://www.esc.state.nc.us/lmi/laus/clf/selmsa2.htm
http://www.esc.state.nc.us/news/CTYRates.html
Map of County Unemployment Rates, Employment Security Commission of North Carolina, N.C. Dept. of Commerce
http://www.esc.state.nc.us/lmi/images/unemprtc.gif

Databases Available Off-Campus

Continued from page 1

...especially important components of this book project which rely heavily on computer database and print literature searches.

The Hunter Scholar Award is a combined effort of Hunter Library, the Office of Academic Affairs and The Office of Research and Graduate Studies to support faculty research efforts. It provides a faculty study in the library, support for literature searching and photocopying, a graduate assistant and one course release time each semester for the award year.

Continued from page 1

...especially important components of this book project which rely heavily on computer database and print literature searches.

The Hunter Scholar Award is a combined effort of Hunter Library, the Office of Academic Affairs and The Office of Research and Graduate Studies to support faculty research efforts. It provides a faculty study in the library, support for literature searching and photocopying, a graduate assistant and one course release time each semester for the award year.

How does this work:
When you make a request for a Web page found on one of the database sites, the library software makes that site think that you are on-campus. It does this by using a piece of software called a proxy server. The WNCLN's proxy server, which resides on the library's computer on campus, actually requests the page for you. The proxy server will then "forward" the page to your computer. The proxy server can only forward pages to library borrowers that have been validated using the library's patron database. In this way, only folks with valid library cards can use this service.

Continued from page 1
The Map Room and GIS
by Anita Oser, Map Librarian

GIS is one of the buzzwords of the day. But how many people really know what GIS stands for and what it does? The acronym GIS translates into Geographic Information System. The geographic component is a mapping program that allows you to show on a map the spatial distribution of data, for example the variation in population density over an area. The Information System component is a database management system that allows you to manipulate data contained in tables, i.e., .dbf files.

When you put these two components together you have a powerful spatial analysis system. It makes it possible to not only represent the spatial distribution of data on a map, but it also allows you to manipulate the data in many different ways and then map the various results. What took hours to achieve in the past can now be done in minutes. But there is a catch, and that catch is the availability and compatibility of data to be mapped. A GIS system allows you to manipulate data, but it does not create the data for you. Data collection is the most labor intensive and costly aspect of GIS. It is not only important that the data collected is accurate, but it must also be georeferenced, the process of tying data to its spatial location. This can be in the form of latitude/longitude readings, street addresses, zip codes, area codes, etc. It all depends on how specific you want to be in locating your data. A latitude/longitude reading, for example, is a more specific location than a zip code.

Who has need for such powerful spatial analysis capabilities? Anyone who works with data that has a spatial component. The US Fish and Wildlife Service and the US Forest Service were two of the first agencies to experiment with GIS. Since then its use has invaded many areas of our lives. Public utilities use it to keep up with their vast networks. Cities use it for planning urban development, maintaining infrastructures, providing police protection, etc. Transportation providers, such as UPS and FedEx, use it to route their cargo. GIS is also heavily used in marketing to identify new markets and to identify the characteristics of these markets. You can rest assured that GIS played a role in locating the Wal-Mart in Sylva. Or have you ever been the recipient of a survey call and were asked for your zip code? Ever wondered why they wanted to know? Now you know. You became a part of a marketing database for use with a GIS system.

So how does the Map Room fit into this scenario? Obviously not big time like the examples above, but GIS plays a legitimate role in the operation of the Map Room. For one thing it is a tremendous help in answering the needs of those students who need an 8.5 x 11 inch map of the Seychelles, for example, to include in a report they are writing. Ever tried to find one? Then there are the more sophisticated needs of patrons that require not only a map but also thematic data to go along with the map. A most recent development in the Map Room is that soon we will be able to post interactive maps on the Web so that patrons can access them even from their homes. The potential for this capability is great. Several groups on campus have already expressed an interest in using it. Definitely exciting times in the Map Room!

A chance to tell us how we are doing!
by Clarissa Fisher, Administrative Librarian

Hunter Library will be conducting a survey in the very near future to determine faculty perceptions of the library's services. This survey will assist the library in responding to information needs both for teaching and research. Faculty will be assisting the library to adjust to change by giving this survey their timely, thoughtful consideration.
The Friends of Hunter Library have recently concluded their annual telephone campaign to raise funds for special projects. With the assistance of the University Advancement office, members of FHL were called and asked—not just to renew their membership—but to give an additional amount, which will be used to fund special acquisitions.

Over the past several years, the FHL has donated several thousand dollars to the Cherokee Phoenix project and other special projects that have made Hunter Library a repository of a number of very special collections! In fact, when you have some extra time, you might want to visit Special Collections and revisit the past!

PC Tip’o’ the Week!

AutoFormatting in Word 97

by Robin Hitch, Computer Support Technician
with assistance from Microsoft

Have you gotten frustrated when editing and formatting a document in Word 97? If so, you are not alone. The most common complaints heard by IS (Information Systems) staff using Microsoft’s Office Professional is “Why can’t I select part of a word?” and “Why won’t this program let me format a list the way I want to?” These common questions can be answered with AutoFormat. This feature of Word 97 can be very intrusive but with a little understanding and training can be effectively productive to your individual style.

By default, when you are selecting a block of text in Word, the selection block advances by a whole word at a time as you drag the cursor over the text. For example, suppose you want to change “this text” to read “these words”. When you try to highlight “is text”, so you can type “ese words” in its place, Word selects the entire word “this.”

If you, like me, find this feature annoying, turn it off! A simple option selection lets Word know you want to select partial words. Choose Tools | Options... click on the Edit tab, and deselect the Automatic Word Selection check box. Click OK to return to your document. This will prevent Word from Auto Selecting Whole Words.

Maybe that feature never was a problem for you. However, if having it automatically change words and formatting is what gets your blood pressure soaring, you can change this option also. Choose Tools | Options... click on the Edit tab, and deselect the Automatic Word Selection check box. Click OK to return to your document. This will prevent Word from Auto Selecting Whole Words.

Work with the different settings and select the ones that may be helpful to you. If you removed all the checks and believe that the feature is off but find it still taking control, ask the Office Assistant for more information about why Word may still AutoFormat your document.

The settings that appear when you select the AutoFormat tab take effect when you click AutoFormat on the Format menu. The settings that appear when you select the AutoFormat As You Type tab take effect as soon as you click OK and start typing in the document. To disable AutoFormat As You Type, you must clear all the settings that appear below it: On the Tools menu, click AutoCorrect. Select the AutoFormat As You Type tab. Clear (remove the check marks from) all the settings under Apply As You Type, Replace As You Type and Automatically As You Type. Click OK. This will turn off all the AutoFormat features in Microsoft Word 97.

Work with the different settings and select the ones that may be helpful to you. If you removed all the checks and believe that the feature is off but find it still taking control, ask the Office Assistant for more information about why Word may still AutoFormat your document.

Friends of Hunter Library

by Linda Gillman

The Friends of Hunter Library have recently concluded their annual telephone campaign to raise funds for special projects. With the assistance of the University Advancement office, members of FHL were called and asked—not just to renew their membership—but to give an additional amount, which will be used to fund special acquisitions.

Over the past several years, the FHL has donated several thousand dollars to the Cherokee Phoenix project and other special projects that have made Hunter Library a repository of a number of very special collections! In fact, when you have some extra time, you might want to visit Special Collections and revisit the past!

As those of us who are active in Friends have often said, “we are small but mighty!” The reality is that Friends is a growing organization, having added a number of new members during 1998. FHL has also added several new dynamic board members, who bring new energy and new talent to the organization. If you are one of those folks out there who haven’t joined Friends yet; we invite you to do so today! Its so easy—just make out a check to Friends of Hunter Library for $15 (per person) and send it to Friends, Hunter Library, WCU, Cullowhee, NC 28723.
New Employee

Paulina Barrier

Hunter Library welcomes Paulina Barrier to the position of State Documents Library Assistant in the Documents Unit. Paulina is responsible for checking in state depository serials and supervising a student assistant who processes and shelves state documents. Paulina evaluates North Carolina websites making recommendations for new sites to include on the unit’s web page. She will also be working with the Marvive Serials Backfile project.

Paulina is from Freetown, Sierra Leone, where she obtained a Higher Teachers Certificate (H.T.C.) at Milton Margai Teachers College in Goderrich, Sierra Leone. She is currently working towards the A.A.S. degree in accounting at SCC. Paulina resides in Cullowhee with her husband Danny, a Police Officer at WCU, and her 7 month old daughter, Nyla.

Recent Publications & Presentations of Faculty & Staff

Next time you are in the library, take a look at what your colleagues have had published last year. The display case is located in front of the stairwell in the Reference area. Publications from a wide range of departments were submitted this year for the display, which is usually held each January-February. It is always interesting, and sometimes inspiring, to see the “finished product” of your colleague’s research endeavors. This year we think that you will be impressed.

Reference Adds New Resources

by Roger Stelk, Director of Public Services

The Reference Unit of Hunter Library has recently added two new online history databases and a 200+ volume collection that focuses on literary biographies. The specifics follow:

America: History and Life — an important research tool for those engaged in the study of North American history or culture. This database abstracts articles and dissertations on the history of the U.S. and Canada as well as articles that consider our current culture. This title also provides indexing to reviews of books, videos, films, and non-print media. Over 2200 serial publications are indexed, from 1964 to the present.

Historical Abstracts — for those involved in history research outside of North America, this is one of the standard research tools. Selectively indexes over 2200 journals as well as dissertations and books. Covers world history from 1450 to the present; indexing begins in 1954.

Both of the above titles are available by selecting Online Resources from the Hunter Library homepage. America: History and Life allows up to six simultaneous users. The Historical Abstracts licensing agreement only allows for one user at a time.

Finally, more than 200 volumes of the Dictionary of Literary Biography have been added to the Reference collection. Each volume of this set consists of collected essays devoted to a single type, genre, geographic area or time period. The essays generally combine biographical and critical aspects of the author and his or her work. Emphasis is also given to the writer’s historical importance and influence.
### HUNTER LIBRARY HOURS

**Spring 1999**

#### Extended Hours

**Sunday, January 31 to Thursday, March 4**

<table>
<thead>
<tr>
<th>Day</th>
<th>March</th>
<th>8:00 a.m. to 6:00 p.m.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Friday</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>Sat. &amp; Sun.</td>
<td>6 &amp; 7</td>
<td>CLOSED</td>
</tr>
<tr>
<td>Monday</td>
<td>8 to</td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td>12</td>
<td>8:00 a.m. to 5:00 p.m.</td>
</tr>
<tr>
<td>Saturday</td>
<td>13</td>
<td>CLOSED</td>
</tr>
<tr>
<td>Sunday</td>
<td>14</td>
<td>4:00 p.m. - Midnight</td>
</tr>
</tbody>
</table>

#### Extended Hours

**Monday, March 15 to Wednesday, March 31**

<table>
<thead>
<tr>
<th>Day</th>
<th>April</th>
<th>8:00 a.m. to 10:00 p.m.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thursday</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Friday</td>
<td>2</td>
<td>CLOSED</td>
</tr>
<tr>
<td>Saturday</td>
<td>3</td>
<td>10:00 a.m. to 6:00 p.m.</td>
</tr>
<tr>
<td>Sunday</td>
<td>4</td>
<td>4:00 p.m. - Midnight</td>
</tr>
</tbody>
</table>

#### Extended Hours

**Monday, April 5 to Friday, May 7**

---

**Hunter’s Clarion**

Hunter Library  
Western Carolina University  
Cullowhee, NC  28723